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What is Timeliner® XE?
The volume of information today is overwhelming. Timeliner XE helps students make meaning
of information by offering an all-in-one, interactive tool with powerful features and over 400  
curriculum-based templates, ready-made projects, and activities.  Timeliner XE supports students in:

• gathering and citing information from anywhere, including the Web
• visually organizing information on a timeline, sequence, or cycle
• communicating their understanding in rich, multimedia presentations

Timeliner XE Features:

Built-in Web Browser
Gather information from the Internet without ever leaving Timeliner XE. Switch to the Research 
tool and use the Timeliner XE browser to find events, take notes, and add images that you can  
see in your timeline instantly.

Timeline Mode
Organize and view information in a timeline in Banner View, Vertical View, Compact View, or  
Slideshow View to help cater to a diversity of learning styles.

Sequence Mode
Create visual diagrams for any content that occurs in a sequence, such as the plot of a book,  
life cycles in science, or project planning.

Event Editor
The Event Editor makes it easy to add events, and sort, cite, and categorize information in one 
place. Use the Editor in any mode or view or while conducting research with the buillt-in Web 
Browser.

Multimedia Library
Use the searchable Media Library to quickly find images, sounds, and video to help illustrate  
projects. Timeliner XE contains more than 1000 images.

Citation Tracker
While you use the Research tools to capture images and research and gather information,  
a built-in Citation Tracker keeps track of the specific information from every different source.

Categories
Help students see patterns and relationships by organizing events into categories with different 
colors, or placing events above and below the timescale.

Links
The Link feature allows you to create dynamic links from project events and notes to
websites, other Timeliner files, and program files such as Microsoft Word documents, PDFs, etc.
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Notes
The Notes feature allows you to add more detailed information to any event on a timeline  
or sequence project. You can also add notes that are not attached to specific events, such as  
introductions, overviews, or instructions.

Cross Curricular Activities

The Main Menu organizes over 400 project templates, ready-made projects, research projects,  
challenges, and Finish Me Activities into categories of social studies, language arts, and science  
and math. 

Project Templates 
Start projects quickly with templates that offer a structure for gathering and organizing information. 
Choose from timeline and sequence templates that cover language arts, science, and social studies.

Ready-Made Projects
Enhance any lesson with a ready-made timeline or sequence project. Choose from an extensive 
variety of projects for all subject areas.

Research Projects 
Help students construct their understanding of sequential information by pointing them to age-ap-
propriate Internet resources, including articles from the Grolier Multimedia Encyclopedia.  
Create project assignments with specific, measurable requirements.

Challenges 
Assess students’ understanding of sequential information by asking them to put events in the  
correct order with engaging, interactive challenges.

Finish Me Activities 
Invite students to analyze information more deeply by attaching notes to files that ask them  
to organize events into categories, attach notes to events, and draw conclusions about cause  
and effect.
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Learning to Use Timeliner XE
There are a variety of ways to learn how to use Timeliner XE. Choose the one that best fits your 
own style of learning or use them all in combination. 

The Getting Started Guide

This guide contains a series of six lessons designed to 
introduce the basic features of Timeliner XE. Each lesson 
uses sample content to walk you through the steps to learn 
how to use the program and is fully illustrated with sample 
screen shots so you’ll know what your computer screen 
should look like while you go through the lesson. Each 
lesson is designed to be done in 15 minutes or less.  This 
guide also includes a chapter with tips for using Timeliner in 
the classroom and a detailed curriculum matrix which aligns 
all the Timeliner XE activity files to learning objectives.

Online Tutorials 

Timeliner XE includes a series of online videos that  
demonstrate how to do specific tasks such as creating a 
new timeline or sequence project, using the Research tools, 
searching the Media Library, and more. These tutorials can 
be accessed from the Timeliner XE Main Menu by clicking 
the Tutorials button.

Reference Guide

The Timeliner Reference Guide contains system require-
ments, installation instructions, and detailed information 
about how to use each feature in Timeliner XE. It can  
be accessed through the Timeliner Help menu and is  
available as a PDF, which you can view and print using 
Adobe Acrobat Reader.  

Quick Reference Card

Each copy of Timeliner XE comes with a handy reference 
card that highlights the basic features, buttons, and tools for 
the program.

Professional Development Workshops

Tom Snyder Productions offers on-site workshops to help teachers learn how to use Timeliner XE 
and integrate it into their classrooms. Our experienced trainers — all former classroom teachers 
— will come to your school to deliver six hour on-site workshops. We are available to consult with 
you on how we can help meet your needs. We invite you to call us at 800-342-0236.
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About Timeliner Documentation

All Timeliner instructions are written for both Mac OS® and Windows-based computers and      
assume that you have a working knowledge of how to use your computer and basic commands 
such as drag, select, click, etc. If you need to review these procedures, refer to the documentation 
that came with your computer.  

Enjoy your experience with Timeliner XE! If you have any questions or comments, please contact us 
at 800-342-0236 or TimelinerXE@tomsnyder.com.
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Installing Timeliner XE

To Install Timeliner XE

Insert the Timeliner XE CD.1.	

Double-click the 2.	 CD icon.

Click 3.	 Setup (Windows) or Install Timeliner XE (Macintosh). 

Follow the on-screen instructions to install the program.4.	

Installation Notes:

By default the program will be saved to: ➤➤

C:\Program Files\Tom Snyder Applications\Timeliner XE\ (for Windows),  
Applications\Tom Snyder Applications\Timeliner XE\ (for Macintosh)

During installation, you will be given a default Save location for project files and activities.  ➤➤

If you want students to be able to access these files from any school computer, we  
recommend you choose another location on a shared network server.

To change the default Save location for project files and activities after the program is  ➤➤

installed, click the Saving tab in Timeliner Preferences and browse to a new location 
such as a shared folder on a network server.

The complete Timeliner XE product contains installations of Adobe AIR (the technology ➤➤

Timeliner XE is built on) and Adobe Reader.

Timeliner XE System Requirements
Platform Operating 

Systems
Processor Memory Free Hard  

Disk Space
CD-ROM Internet     

Access
Monitor

Windows Microsoft® 
Windows® 2000 
with Service 
Pack 4
Windows XP 
with Service 
Pack 2 Windows 
Vista® Home 
Premium, Busi-
ness, Ultimate, or 
Enterprise

Intel® 
Pentium® 1GHz 
or faster

512MB of RAM

(1 GB 
recommended)

1 GB For 
installation 
only

Required 
to use 
Timeliner’s 
built-in 
browser in 
Research 
mode

16-bit colors, 
1024x768 
minimum 
resolution

Macintosh Mac OS X 
v10.4.9, 10.4.11, 
10.5.1 or 10.5.3

Intel Core™ Duo 
1.83GHz or faster 
(recommended) 
or PowerPC® G4 
1GHz or faster

512MB of RAM

(1 GB 
recommended)

1 GB

Important reminder!
If you use hardware that just meets the system requirements, the application will run correctly; 
however, it may run somewhat slower than desired.  All features will be present and function 
properly. Using hardware below the system requirements is not recommended or supported, and 
may cause the program to run too slowly or prevent certain features from functioning properly.
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To Register Timeliner XE

You can register your copy of Timeliner XE at the end of the product installation process. You can 
also register online at http://www.timelinerxe.com. 

As a registered customer, you receive:
Information about product updates➤➤

Discounts on Timeliner XE upgrades➤➤

Free telephone, fax, and email technical support➤➤

To Remove Timeliner XE

Windows
Click the 1.	 Start button, point to Settings, and then click Control Panel.

Double-click 2.	 Add/Remove Programs. 

Select 3.	 Timeliner XE in the list box, and then click Add/Remove.

Macintosh
Drag the Timeliner XE folder to the Trash, and then empty the Trash.

Upgrading Timeliner

When you install Timeliner XE, it does not overwrite any earlier version of Timeliner installed on 
your computer. This enables you to keep files created in the earlier version of Timeliner.

Opening Timeliner 5.0 Files

 Files created using TimeLiner 5.0 can be opened by Timeliner XE. However, while all events should 
carry over from the original file, you may experience issues such as distorted graphics, missing 
categories, and missing labels.
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Customer Service

If you have any questions, comments, or need help with Timeliner XE, you can contact us by email, 
telephone, or fax.

For the latest technical information, go to www.timelinerxe.com.

Toll-free: 800-342-0236 (U.S. & Canada only)
Local or International: 617-926-6000
Hours: Monday through Thursday, 8 a.m. to 6 p.m. EST; Friday, 8 a.m. to 5 p.m. EST
Email: tech@tomsnyder.com
Web: www.tomsnyder.com

When you call, please have the following information available:

Software title and version number (found on the CD-ROM and in the About box)➤➤

Your computer’s operating system (e.g., Mac OS X 10.5 or Windows 2000)➤➤

Your computer’s memory (e.g., 512 megabytes of RAM)➤➤

Your computer’s speed (e.g., 1.2 GHz)➤➤

If possible, please have the software running on a computer close to the telephone when you call.



Timeliner XE Reference Guide

11

Opening Timeliner

Macintosh 
Open the Timeliner XE folder, and then double-click the Timeliner XE icon. The Main Menu 
screen appears. 

Windows
Click the Start button, choose Programs, and then choose TimeLiner XE. The Main Menu 
screen appears.

The Main Menu

The Timeliner XE Main Menu presents three tabs with all the options for creating and opening 
projects, templates, and activities.  It also has a Tutorials button that when clicked will open the 
online tutorial videos.

Create a New Project➤➤ :  Use this tab to create a new timeline or sequence project  
or open a ready-made template.

Choose an Activity:➤➤  Click this tab to open or create a Research, Challenge, or  
Finish Me Activity.

Open a Project:➤➤  Use this tab to access your own saved projects or hundreds of  
ready-made timeline and sequence projects. 

Main Menu
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Create a New Timeline or Sequence Project

Timeliner opens to the Create a New Project tab by default. From here you can open a new  
timeline or sequence project, or you can open a ready-made template.

To Open a New Timeline 
From the Main Menu, click the 1.	 Create a New Project Tab.
Select the 2.	 Blank option in the Timeline column, and Click OK.
The 3.	 Timeline Setup window appears.

To Open a New Sequence 
From the Main Menu, click the 1.	 Create a New Project tab.

Select the 2.	 Blank option in the Sequence column, and click OK.

The 3.	 Sequence Setup window appears.

To Open a Ready-Made Template
Ready-made templates are timeline or sequence project templates that include events with no 
dates, categories, and images. They are designed to provided a jump start for common student 
projects such as family history, biographies, etc.

From the Main Menu, click the 1.	 Create a New Project Tab.

Select a 2.	 ready-made template from the either the timeline or sequence column, and  
click OK to open the template. 

Click to open a 
new timeline

Timeline ready-
made templates

Scroll down to see 
more ready-made 

templates

Click to open a  
new sequence

Sequence ready-
made templates

Scroll down to see 
more ready-made 
templates 

Main Menu
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Create or Open an Activity

The Choose an Activity Tab presents the options to open or create a Research, Challenge, or  
Finish Me Activity. 

To Open an Activity 
From the Main Menu, click the 1.	 Choose an Activity Tab.

Select an Activity type: 2.	 Research, Challenge, or Finish Me.

Select a 3.	 subject from the Subject column, select an Activity from the list, and click Open.

Follow the on-screen instructions to complete the Activity. 4.	

See the section on Timeliner Activities for more information.

To Create an Activity 
From the Main Menu, click the 1.	 Choose an Activity Tab.

Click the 2.	 Create Activity button.

Select the type of activity to want to create and click 3.	 OK.

Follow the on-screen instructions to create the activity.4.	

See the section on Timeliner Activities for more information.

Click to open a 
new Activity

Select a subject

Scroll down 
to see more 

subjects

Select an Activity 
type

Select an Activity

Scroll down to see 
more Activities

Choose an Activity Screen
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Open a Ready-Made or Saved Project

The Open a Project Tab gives you access to hundreds of ready-made timelines and sequences.  
You can also access your own saved projects from this tab.

To Open a Ready-Made Timeline or Sequence
From the Main Menu, click the 1.	 Open a Project Tab.

Select a 2.	 subject from the Subject column, a topic from the Topic column, and a ready-made 
project from the File column.

Click 3.	 Open.

To Open a Saved Timeline or Sequence
From the Main Menu, click the 1.	 Open a Project Tab.

Select 2.	 My Files from the Subject column (you may need to scroll down). Timeliner takes you  
to the My Projects folder, where you can select your saved project. 

Note: You can have multiple files open at once. When multiple files are open, each file has a tab 
with the saved file name (not the title) at the top of the screen. The active file (Untitled in the 
example below) has a white tab. To close a file, click the  on the right side of the tab.

 

Choose a Project Screen
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The Timeline Setup Window

The timeline Setup window allows you to preset many common timeline options before beginning 
a new project. The window contains four tabs – General, Events, Categories, and Printing. 

There are two ways to access the Setup window:

The window will automatically open when you start a new timeline.➤➤

When you have a timeline project open, choose ➤➤ Setup from the File menu and the 
Setup window will appear.  Once you open a new timeline project, you cannot change the 
Type of timeline you chose in the initial setup. You can change or enter the Timeline Title, 
the Start date, and the End date.

Note:  If you enter a new Start or End date and click OK, the timeline is redrawn to include  
the new parameters. However, if the new Start or End date conflicts with events you have  
already entered on your timeline, the conflicting date entry will be ignored and the timeline  
will remain unchanged.

Setup Window
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General Setup for Timelines

The General Setup tab provides several options for customizing the type of timeline you want  
to create.

Timeline Title: 
This optional text field allows you to enter a title for your timeline up to 100 characters long.  
The timeline title will appear on the timeline. The timeline file can be saved with a different name.

Timeline Type: 
There are six different timeline options: Standard (selected by default), One Year, One Month,  
One Week, One Day, and Geologic.

Standard timelines are typical chronological timelines. For this type of timeline, events 
can be entered as general as 2008 or as specific to the minute as March 2, 2008 8:30 PM.

When you choose this type, two optional text fields appear, labeled Start and End.  
You can enter start and end dates as general as 2008 or as specific to the minute as  
March 2, 2008 8:30 PM.

One Year timelines can be used to chart the events of a year. 

When you choose this type, a drop-down menu labeled Start appears, which contains a 
list of months: January~December. Choose a starting month and Timeliner automatically 
creates a timescale that begins on the first day of that month and ends 12 months from it.

One Month timelines can be used to display the events of a typical month. 

When you choose this type, a drop-down menu labeled Select the number of days in your 
month appears. Choose the number of days for your month and Timeliner automatically 
creates a timescale using the number of days specified.

Setup Window

Timeline
Types
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One Week timelines can be used to show what occurs regularly on certain days  
of the week.

When you choose this type, a drop-down menu labeled Start appears. Choose the day  
of the week on which you want your timeline to start and Timeliner automatically creates 
a seven-day timescale that starts on that day and ends seven days later.
	
One Day timelines show what happens at different hours of the day.

When you choose this type, a drop-down menu labeled Start appears. Choose the time 
of day at which you want your timeline to start (midnight and noon are used in place of 
12 AM and 12 PM), and Timeliner automatically builds a timescale that begins on that time 
and ends 24 hours later.
	
Geologic timeline events may range from 100 billion years ago to the Present.

When you choose this type, a text field labeled Start appears. This optional field  
accepts alphanumeric start times, such as 900, 900 M, 900 MYA. Enter a start date  
and the program will assume millions of years ago. If you enter a date followed by  
B or BYA, the program will assume billions of years ago. 

Note: If you have previously specified European date or time formats in Preferences,  
the Start and End text Fields will accept these formats, and the Start drop-down menu  
for One Day will display 24-hour time.

Start/End: 
Different Start and End options are displayed based on the timeline type you select. Specifying start 
and end times is optional.
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Events Setup for Timelines

The Events Setup tab provides several options for formatting the default text and event styles for 
your timeline. Once the timeline is open, you can also change any of these styles.

Text: 
Choose from the standard options for formatting the event text styles: Font and Font Size; Bold, 
Italic, and Underline; and a Font Color palette.

Flags: 
Click each icon to see a drop-down list of choices for the Event Flag and Flagpole style, flag fill 
color, and line color. The last flag on the right displays the choices you make.

Spans:  
Click each icon to see a drop-down list of choices for the Span Event and Span Pole style, fill color, 
and line color. The last icon on the right displays the choices you make.

Put spans above timescale: Select this option to place span events above the timescale.

Put spans below timescale: Select this option to place span events below the timescale.

Setup Window (Events)

Text Style

Flag Style

Span Style

Span Location
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Categories Setup for Timelines

Categories are terms that can be attached to events. You can assign specific text colors and  
formatting styles to categories in order to help visually organize them into groups. For example,  
in a timeline of presidents, you may want to create categories for Democrat and Republican. Use 
the options in the Categories Setup tab to define event categories for your timeline.

Add Category: 
Enter the category name (up to 40 alphanumeric characters) in this text field and click Add.   
Timeliner automatically defines a new font color for every category you add.

Edit Category: 
This drop-down list contains all the categories that have been added to the timeline project. 
Choose a category from the list, and it appears in the Preview box below, where you can choose 
to format a new font style and color, rename it, or delete it.

Text options: 
Contains the standard options for formatting the category: Font and Font Size; Bold, Italic, and Un-
derline; and a Font Color palette.

Preview box: Displays a preview of your category, including its color and font size and style.

Rename: Click to open a window where you can edit the category name in the Preview box.

Delete: Deletes the category that is in the Preview box.

Show legend: (Selected by default) Displays a legend on the timeline defining each category 
and its associated color.  Uncheck the box if you do not wish to show a legend on your timeline. 
This check box is unavailable until you add a category.

Setup Window (Categories)

Preview Box



Timeliner XE Reference Guide

20

Printing Setup for Timelines

The Printing Setup Tab lets you choose between letter or legal paper size for printing.

Setup Window (Printing)
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Adding Events to a Timeline
Once you have selected your setup options, a timeline window will open with the Event Editor on 
top and the timeline area below.  The sample below shows a few events in the Event Editor and in 
the timeline. There are two ways to add events to a timeline. You can use the Add Event button 
or use the Event Editor.

Sample Timeline 

Note:  Events do not have to be added in chronological order. Timeliner will put events in order.

Add Event 
button

Event 
Editor

Timeline
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Using the Timeline Add Event Button 

Open a timeline project and click the 1.	 Add Event button   on the main toolbar at the 
top of the screen. An Add Event window opens.

 

Enter the event date or time in the 1.	 Start field.

If you are entering an event that takes place over a span of time, select the 2.	 To checkbox  
and enter the end time or date in the End field. 
 

 
Note:  Event dates or times can be entered in several formats. For a complete list, refer to the 
Date and Time Formats Accepted by Timeliner XE section.

Enter a description of the event in the 3.	 What field.

Use the 4.	 Category field to choose or add a category for the event (optional).

Click 5.	 OK.

Click to enter 
a date range
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Using the Timeline Event Editor
The Event Editor appears by default at the top of a timeline project screen. It contains rows of six 
column fields. Each field represents one event and can be used to add or edit event information. 

Enter information into the ➤➤ When and What fields to generate an Event Flag on the 
timeline below.  A new event row is then generated automatically. 

Use the other optional column fields to add additional information to an event at any time. ➤➤

Use the ➤➤ Tab key to move from one column to the next. 

Click in the numbered column of the Event Editor to select the entire event row.➤➤

To change the width of a column, place your cursor on the line just before its title on the ➤➤

top bar and drag left or right.  

Each column field in the Event Editor is explained in detail below.

Event Editor:  When Field  
Use this column field to enter a date or time for a timeline event.

Enter a single date or time (e.g., March 2, 1973) to generate an ➤➤ Event Flag on the timeline.

Enter two dates or times separated by a dash (e.g., April 2004 – April 2010) to generate a ➤➤

Span Event on the timeline.

Event dates or times can be entered in several formats. For a complete list, refer to the ➤➤

Date and Time Formats Accepted by Timeliner XE section.

Event Editor:  What Field
Use this column field to enter or edit an event description. It is best to keep event descriptions 
brief, but you can enter up to 100 characters in this field. If more text is entered than will fit in the 
field, the text will truncate where the field ends. To view the entire length of text, place your cursor 
over the field.

Event Editor: Category Field
This field allows you to assign, add, edit, or delete event categories. Click in a category field and 
a drop-down list appears with all available categories and options to add, edit, or delete categories. 
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Once a category is assigned to an event, its text style and color is applied to the event in the time-
line, and the name appears in the Category column of the Event Editor in its assigned color.

Note:  The maximum number of categories a file can have is 20.

Event Editor: Notes Field	
Notes allow you to add additional information to a timeline or to specific events on the timeline. 
To use the Event Editor to add notes to specific events, type text into the Notes field.  This will 
automatically create a note as soon as you tab or click off the field. You can add a note of up to 
500 characters; however, the Notes field will not grow with the amount of text entered.  If more 
text is entered than will fit in the field, the text will truncate where the field ends. To view the 
entire length of text, place your cursor over the field.

See also Adding Notes to a Project.

Event Editor: Citations Field	
Place your cursor over the 1.	 Citations field and click the Add button. The Citation Tracker 
window opens.  
 
Note: The Citation Tracker window contains a variety of options for citing event information 
and media. For more information, see the section on citing research data.

Once a citation has been added to an event, an icon appears in its Citations column. Click the 2.	
icon to open the Citation Tracker, and select the appropriate tab to view your citation.

Event Editor: Media Field	
The Media field displays icons that represent the media types you have added to an event. The 
icons are display only.

Add Category Window
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Edit Event Text 

Once you have entered events, you can edit the text directly in the Event Editor or from within an 
Event Flag.

Select the event text directly in the ➤➤ Event Editor, make your edits, and press Return 
[Enter].

Double-click the ➤➤ Event Flag and edit the text within the flag. When you have completed 
the edit, click in the timeline window to deselect the text. 
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Formatting the Timeline

To Format Event Flags

To modify the style of an Event Flag, click it once to select it and then use the available tools on the 
Formatting Toolbar to modify it. To change the size of a flag, drag its handles in or out.

To Format Span Events

To modify the style of a Span Event, click it once to select it and then use the available tools on the 
Formatting Toolbar to modify it.

To Format Notes

To modify the style of a note, click it once to select it and then use the available tools on the 
Formatting Toolbar to modify it.

Use the Text Style tools to modify 
the font, font size, style, and color.

Flag Style 
Menu

Flag Pole 
Menu

Line Weight 
Menu

Fill Color
Menu

Line 
Color
Menu

Flag 
Effects
Menu

Use the Text Style tools to modify 
the font, font size, style, and color.

Span Style 
Menu

Line 
Color
Menu

Span 
Effects
Menu

Span Pole 
Menu

Line Weight 
Menu

Fill Color
Menu

Use the Text Style tools to modify 
the font, font size, style, and color.

Line 
Color
Menu

Note 
Effects
Menu

Line Weight 
Menu

Fill Color
Menu

Tip:  Choose the default span style,        click the fill color button,        and select a light color 
such as yellow to make a span time period more noticeable on your timeline.
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To Format the Timescale

To modify the style of the timescale, click it once to select it and then use the available tools on the 
Formatting Toolbar to modify it.

To Add Color to the Background

To change the color of the timeline background, click the project background and then click the 
color button         to choose a color.

To Move an Event Flag Position

To manually adjust the vertical position of Event Flags or Span Events on the timeline, click to select 
an event and drag it up or down. You can even drag events into position below the timescale axis. 
To adjust the horizontal position of an Event Flag on top of its pole, click to 
select the flag and drag it left or right.

To Expand and Compress Your Timeline

There are two ways to expand or compress the relative length of the timescale on your timeline. 
Try them both: 

Click the ➤➤ Expand button to increase the timescale and the Compress button to 
decrease the length of the timescale. 

Move the Slider Control between the words Expand and Compress back and forth to ➤➤

adjust the timescale. 

To Use the Zoom Controls
Zoom in to or out of a timeline window with the Zoom Controls.

 
        

   

Line 
Color
Menu

Line 
Weight 
Menu

Fill Color
Menu

Timescale 
Menu

Slider Control

Zoom Out 
Button

Zoom In 
Button

Zoom to 
100%

Zoom Level 
Menu
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Timeline Views

The data you enter into the Event Editor can be viewed four different ways — Banner View, 
Vertical View, Compact View, and Slideshow View. Use the View buttons on the main 
toolbar to switch views. The process for adding and editing events, media, notes, links, etc. is the 
same in all but the Slideshow View.

Note:  Only the category formatting is maintained between views. Follow the formatting steps 
in the Formatting the Timeline section to format events, fonts, styles, sizes, colors, etc. in the Verti-
cal and Compact Views. For more information on setting up a multimedia slideshow, see Using the 
Slideshow View.

Banner View                                Vertical View

Compact View                               Slideshow View

This is a sample setup window for making a slideshow. 
For more information on how to set up a multimedia 
slideshow, see Using the Slideshow View.
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Merging Timelines

The Merge feature allows you to combine the data from two timelines into a single timeline. When 
you choose a timeline file to merge, if that file does not contain any categories, you have the op-
tion to assign all its events to a category to make it easier to distinguish between events in the 
merged timeline. 

To Merge Two Timelines

Open the first timeline to merge. Make sure the timeline is saved before you continue. 1.	

Click the 2.	 Merge button       on the main toolbar and a window opens asking you to select 
the timeline you want to merge with. 

Next, 3.	 Browse to select your second timeline. (If you save your timelines into the default My 
Projects folder, you can find that folder in the My Timeliner XE documents folder in the main 
Documents folder.) Click Select.

If the second timeline to merge with does not contain any categories, you will get a win-➤➤

dow with the following message: “Would you like to assign a category to all events in this 
timeline? This makes it easier to distinguish between events in the merged timeline.”  If you 
click Yes, the Categories window opens and you can create the new category. The one 
new category will then be automatically assigned to all events in the second timeline. Then, 
the merge will proceed automatically. Clicking No proceeds with the merge without as-
signing any categories.

The data from the two timelines will merge into the first timeline file. After merging, only one 1.	
timeline file is open – a merged file containing data from both timelines. Save the new file with 
a new name.

Rules for Merging Timelines
Only similar timeline types can be merged (such as a One Week timeline with another ➤➤

One Week timeline). 

Timelines cannot be merged with sequences.➤➤

Timeliner XE files cannot be merged with Timeliner 5 files.➤➤

The Merge operation cannot be undone.➤➤

Note:  If you merge with a file that contains links to other files, you must save the merged file to 
the same folder as the original file that includes the links, otherwise the links will be broken.
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Date and Time Formats Accepted by Timeliner XE
Timeliner XE is smart and flexible about interpreting different date formats. When you enter a 
new event date, the program understands different date formats and abbreviations. For example, 
you could type Dec 26, 1972 7:50 AM, or 12/26/72 7:50 AM and the program will understand it as: 
December 26, 1972, 7:50 AM.

For a Standard timeline, you can enter a variety of date formats from a year, down to the minute, 
and everything in between. You can enter as much or as little detail as you choose. For example, 
you might enter December 1972 or you might enter Tuesday December 26, 1972.  For example: 

2008 
January 2008
January 5, 2008 (with or without punctuation)
1/2008
1/5/2008
January 5, 2008 02:30 PM
1/5/2008 02:30 PM

Note: By default, an hour time entered is interpreted as AM unless specified as PM.

Numeric format
When entering dates as numbers and slashes (e.g., 12/26/72), be sure to input the date in order of 
month/day/year. Do not put a space before or after a slash. If you want to use a European style of 
day/month/year, you can change to that format in the Timeliner Preferences Formats tab. 

Entering 20th- and 21st-century dates
Timeliner makes entering both 20th-century and 21st-century dates easier.  Years ending in 00–30 
are interpreted as 21st-century dates (i.e., 2000 through 2030) to make it easier to enter current 
events and events in the near future. Years ending in 31–99 are interpreted as 20th-century dates 
(i.e., 1931 through 1999) to make it easier to enter most 20th-century historical dates. If you want 
to enter other dates, you’ll need to enter all the digits for the year.

Shortcuts 
To enter dates in the late 20th century (1931–1999) quickly, input the date with numbers and 
slashes. For example, 12/26/72 will be interpreted as December 26, 1972. You can use other 
shortcuts, including the first three letters of a month followed by either a space or a slash. Here are 
some examples:

You Enter 	 The Result
12/26/72 	 December 26, 1972
dec/26/72 	 December 26, 1972
12/72 	 December 1972
72 AD	 72 AD
210 BC	 210 BC
4/14/1865 	 April 14, 1865
1/1/00 	 January 1, 2000

Note:  For years between 1 and 99 AD, you must enter AD after the year.
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The Sequence Setup Window

The sequence Setup window allows you to preset many options before beginning a new project. 
The window contains four tabs – General, Events, Categories, and Printing. 

There are two ways to access the Setup window:

The window will automatically open when you start a new sequence.➤➤

When you have a sequence project open, choose ➤➤ Setup from the File menu and  
the Setup window will appear.  

Sequence Setup Window
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General Setup for Sequences

The General Setup tab provides several options for customizing the type of sequence you want  
to create.

Sequence Title
This optional text field allows you to enter a title for your sequence up to 100 characters long. This 
title will appear on the sequence. The sequence file can be saved with a different name.

Sequence Type
There are three different sequence options: Horizontal (selected by default), Vertical, and Circular.

Horizontal sequences display events from left to right. With this type of sequence, you 
have the option to select Show baseline. A baseline is a horizontal line drawn under the 
sequence with Start and End labels at either end of the line.  
 

Note: The words Start and End can be edited when the sequence is open.

Vertical sequences display events from top to bottom. 

Circular sequences display events in a cycle. By default, the event at the top center of the 
circle will be considered the first event and the next clockwise event will be considered 
the second event and so on. Select the Counter-clockwise option if you prefer your 
sequence to follow a counter-clockwise direction instead.

Brainstorming Area
The option to show a Brainstorming Area is selected by default. It provides a staging area above 
the sequence where you can quickly add new events before dragging them into the sequence.

Sequence Setup Window
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Events Setup for Sequences

The Events Setup tab provides several options for formatting the default text, Event Box, and arrow 
styles for your sequence. Once the sequence is open, you can also change any of these styles.

Text: 
Contains the standard options for setting up formatting for the event text styles: Font and Font 
Size; Bold, Italic, and Underline; and a Font Color palette.

Events: 
Click each icon to see a drop-down list of choices for the Event Box and arrow style, fill color,  
and line color. The last box on the right displays the choices you make.

Sequence Setup Window (Events)
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Categories Setup for Sequences

Categories are terms that can be attached to events. You can assign them to specific text colors 
and formatting styles in order to help visually organize categories into groups. For example, in a se-
quence of a story, a user may want to create categories for plot development and character devel-
opment. Use the options in this Categories Setup tab to define event categories for your sequence.

Add Category: Enter the category name (up to 40 alphanumeric characters) in this text field 
and click Add.  Timeliner automatically defines a new font color for every category you add.

Edit Category: This drop-down list contains all the categories that have been added to the 
sequence project. Choose a category from the list and it appears in the Preview box below, where 
you can choose to format a new font style and color, rename it, or delete it.

Text options: Contains the standard options for formatting Font and Font Size; Bold, Italic, and 
Underline; and a Font Color palette.

Preview box: Displays a preview of your category, including its color and font size and style.

Rename: Click this to open a small window where you can edit the category name in the Pre-
view box.

Delete: Deletes the category that is in the Preview box.

Show legend: (Selected by default) Displays a legend on the sequence defining each category 
and its associated color.  Uncheck the box if you do not wish to show a legend on your sequence. 
This check box is unavailable until you add a category.

Sequence Setup Window (Categories)
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Printing Setup for Sequences

The Printing Setup tab lets you choose between letter or legal paper size for printing.

Sequence Setup Window (Printing)
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Adding Events to a Sequence
After you enter your setup information, a new sequence project screen appears.  The Brainstorm-
ing Area is at the top of the screen with the sequence below. Use the Add Event button and 
the Brainstorming Area to create events. Then drag the events from the Brainstorming Area into 
the sequence below. You can also use the Event Editor to add events to a sequence.

To Use the Sequence Add Event Button 

Click the 1.	 Add Event button on the main toolbar of the sequence   .

A new Event Box containing a question mark appears in the Brainstorming Area, and a corre-2.	
sponding blank Event Box appears in the sequence below. 

Double-click the Event Box in the Brainstorming Area, and a text box appears.3.	

Enter your event text and then click off the text box.4.	

Repeat steps 1– 4 to add additional events.5.	

Drag each6.	  Event Box from the Brainstorming Area into the appropriate blank box in the se-
quence.

To move an Event Box back to the Brainstorming Area, right-click (Ctrl-click) an Event Box and 7.	
choose Move to Brainstorming Area from the menu.

Add Event 
button

Brainstorming 
Area

Sequence 
Area

 1.	

Sample Sequence Project
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Using the Sequence Event Editor

Click the Event Editor button on the main toolbar to view the Event Editor at the top of a 
sequence project screen. It contains rows of six column fields. Each field can be used to add or edit 
event information. Each row represents one event. 

Enter information into the ➤➤ What field to generate a new Event Box in the Brainstorming 
Area and in the sequence below.  A new event row is then generated automatically. 

Use the other optional column fields to add additional information to an event at any time. ➤➤

Use the ➤➤ Tab key to move from one column to the next. 

To change the width of a column, place your cursor on the line just before its title on the ➤➤

top bar and drag left or right. 

The Order column is for display only.  It will remain blank until you begin dragging Event ➤➤

Boxes into the sequence. You cannot edit the number in this column. It will update dynami-
cally as you position events in a sequence.

Each column field in the sequence Event Editor is explained in detail below.

Event Editor:  What Field
Use this column field to enter or edit an event description. It is best to keep event descriptions 
brief, but you can enter up to 100 characters in this field. If more text is entered than will fit in the 
field, the text will truncate where the field ends. To view the entire length of text, place your cursor 
over the field.

Event Editor: Category Field
This field allows you to assign, add, edit, or delete event categories. Click in a category field and a 

Event Editor
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drop-down list appears with all available categories and options to add, edit, or delete categories. 
Once a category is assigned to an event, its text style and color is applied to the event in the se-
quence, and the name appears in the Category column of the Event Editor in its assigned color.

Note: The maximum number of categories a file can have is 20.

Event Editor: Notes Field	
Notes allow you to add additional information to a sequence or to specific events on the se-
quence. To use the Event Editor to add a note to a specific event, type text into its Notes field.  
This will automatically create a note as soon as you tab or click off the field. You can add a note of 
up to 500 characters; however, the Notes field will not grow with the amount of text entered. 
If more text is entered than will fit in the field, the text will truncate where the field ends. To view 
the entire length of text, place your cursor over the field.

See also Adding Notes to a Project.

Event Editor: Citations Field	
Place your cursor over the 1.	 Citations field 
and click the Add button. The Citation                                                                     
Tracker window opens.  
 

Note:   The Citation Tracker window contains a variety 
of options for citing event information and media. For 
more information, see the section in this guide on using 
the Citation Tracker.

Once a citation has been added to an event, an icon ap-2.	
pears in its Citations column. Click the icon to open the 
Citation Tracker, and select the appropriate tab to view 
your citation.

Event Editor: Media Field	
The Media field displays icons that represent the media types you have added to an event. The 
icons are display only.

Citation Tracker
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Editing Sequence Text 

To Edit Event Text
Once you have entered events, you can edit the text directly in an Event Box or open the Event Edi-
tor and edit the text from there.

Double-click the text in an Event Box. When you have completed your edits, click in the ➤➤

sequence window to deselect the text box.

Click the ➤➤ Editor button to open the Event Editor. Select and edit the text and press 
Return.

To Edit Baseline Labels
You can change the default Start and End labels on the baseline so that they better suit the content 
of your sequence.

Double-click either the Start or End label on the baseline to select it, make your edits, and ➤➤

click in the sequence window to deselect the text box.
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Formatting the Sequence

To Format Event Boxes

To modify the style of an Event Box, click it once to select it and then use the available tools on the 
Formatting Toolbar to modify it. To change the size of a box, drag its handles in or out.

To Format the Baseline

To modify the baseline style or text, click it once to select it and then use the available tools on the 
Formatting Toolbar to modify it.

To Format Arrows

To modify the style and color of an arrow, click it once to select it and then use the available tools 
on the Formatting Toolbar to modify it.

Use the Text Style tools to modify 
the font, font size, style, and color. Box Style 

Menu

Line Weight 
Menu

Fill Color
Menu

Line 
Color
Menu

Box 
Effects
Menu

Use the Text Style tools to modify 
the font, font size, style, and color.

Baseline 
Style Menu

Arrow 
Color
Menu

Arrow 
Style 
Menu
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To Add Color to the Background

To change the color of the sequence background, click the project background and then click the 
Fill Color menu to choose a color.

To Move an Event Box

You can adjust the vertical/horizontal position of an Event Box, and you can change the order of an 
Event Box in a sequence. 

To manually adjust the position of an Event Box on the sequence, click to select it and drag ➤➤
it up or down, in the Horizontal View, or side to side, in the Vertical View. Events in the 
Circular View cannot be moved out of position. 

To align all Event Boxes in a sequence, ➤➤ right-click (Ctrl-click) an Event Box and choose 
Align all with this event from the drop-down menu.

To change the order of an Event Box in a sequence, click to select it and then drag and ➤➤
drop it into a different location in the sequence order.  

To Delete an Event Box

Click on a box in the Brainstorming Area or in the sequence and choose Delete from the Edit 
menu, or right-click (Ctrl-click) a box and choose Delete from the menu.

To Expand and Compress a Sequence

There are two ways to expand or compress the length of a sequence.

Click the ➤➤ Expand button to increase the length and the Compress button to de-
crease it. 

Move the Slider Control between the words Expand and Compress back and forth to ➤➤

adjust the sequence length. 

To Use the Zoom Controls
Zoom in to or out of a sequence window with the Zoom Controls.

 
        

   
 

 
 

Zoom In 
Button

Zoom Out 
Button

Zoom to 
100%

Zoom Level 
Menu

Slider Control
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Sequence Views

You can view sequence data four different ways — Horizontal View, Vertical View, Circular 
View, and Slideshow View. Use the View buttons on the main toolbar to switch views. The 
process for adding and editing events, media, notes, links, etc. is the same in all but the Slideshow 
View.

Note: Only the category formatting is maintained between views. Follow the formatting steps in 
the Formatting the Sequence section to format events, fonts, styles, sizes, colors, etc. in the Verti-
cal and Circular Views. For more information on setting up a multimedia slideshow, see Using the 
Slideshow View.

Horizontal View                              Vertical View

Circular View                                  Slideshow View

This is a sample setup window for making a slideshow. 
For more information on how to set up a multimedia 
slideshow, see Using the Slideshow View.

Note:  To move a circular sequence, click in 
the center of the sequence and a gray circle 
appears. Click the gray circle and drag the 
sequence to your desired location.
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Adding Categories to Events
Categories are terms that can be attached to events in order to help organize them into groups. 
For example, in a timeline of presidents, you may want to create categories for Democrat and 
Republican. You can create new categories from the Event Editor or the Setup window.

To Create a New Category with the Event Editor

Click in the 1.	 Category column of the Event Editor  
and a small drop-down window appears. 

Click 2.	 Add Category and the drop-down window 
expands to present more options.

Type the category name in the field.3.	

Use the formatting buttons to select                                                                                    4.	
a text style and color.

Click 5.	 Save and the new category is added to the  
list, the drop-down window closes, and the category  
is automatically assigned to the event.

To Create a New Category from the Setup Window

Choose 1.	 Setup from the File menu. In the Setup window, click the Categories tab.

Enter a category name in the Add Category fiel2.	 d and click Add.  The category appears in the 
Preview box. Timeliner automatically assigns a color and text style. If desired, use the text for-
matting options to assign a different color or font.

Click 3.	 OK. 

To Assign a Category to an Event

After at least one category has been created, use the Event Editor to assign categories. 

Click in the 1.	 Category column of the event to which you want to assign a category. 

Select a category from the drop-down window that appears. Once a category is selected, the 2.	
drop-down window closes.

Tip: Another way to assign a category is to right-click (Ctrl-click) on a selected event and 
choose Add Category from the drop-down menu. This opens the same drop-down window 
containing all the categories that have been created. Select a category to assign it to the event and 
the drop-down window closes.

Add Category Window
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To Remove a Category from an Event

Click in the 1.	 Category column of the event from which you want to remove a category. 

Select 2.	 None from the drop-down window that appears. The category is removed from the 
event and the drop-down window closes.

To Show or Hide a Category Legend

When categories are assigned to events, Timeliner automatically creates a legend defining each 
category and its associated color. 

To remove a legend, choose ➤➤ Setup from the File menu. Click the Categories tab on the 
Setup window. Click to deselect the Show legend check box, and click OK.

To show the legend again, choose ➤➤ Setup from the File menu. Click the Categories tab 
on the Setup window. Click to select the Show legend check box, and click OK. 

To Arrange Events by Category

If your timeline events are assigned to categories, you can arrange them two different ways:
 

Choose ➤➤ Arrange Flags from the Tools menu and then choose Into groups by  
category. This option will stack events with the same category along the same plane  
on the timeline.

Choose ➤➤ Arrange Flags from the Tools menu and then choose On alternate sides 
of the timeline by category. This option will organize events with the same category 
either all above or all below the timescale. 

To Edit or Delete Categories from the List

You can edit or delete categories in the Event Editor or in the Setup window.

To Edit a Category in the Event Editor
Use the Event Editor to edit any category that you have created. Any color or font changes you 
make to a category will apply to all events assigned to that category. 

Click in the 1.	 Category column and click the Edit icon next to the category you want to edit. 
The drop-down window displays the category name, formatting options, and a Save button. 

Edit the name of the category in the Name field.  ➤➤

Use the formatting buttons to change the font and color. ➤➤

Click 1.	 Save and the updated category is reflected in the list, the edit window closes, and the 
category changes are automatically applied to all events assigned to that category.

Click off the category window to close it.2.	
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To Delete a Category in the Event Editor

Click in the 1.	 Category column and a drop-down window appears.

Click the 2.	 Delete icon        next to the category you want to delete. This will delete the cat-
egory from the list and also remove it from any events it was assigned to.

Click off the category window to close it.3.	

To Edit or Delete a Category in the Setup Window

Use the Setup window to edit any category that you have created. Any color or font changes you 
make to a category will apply to all events assigned to that category. 

Choose 1.	 Setup from the File menu. In the Setup window that appears, click the  
Categories tab.

Click the 2.	 Edit Category drop-down list and select the category name you want.

The category name appears in the Preview box. From here you can use the formatting tools 3.	
to change its color and text style, click the Rename button to edit the name, or click the 
Delete button to delete it. This will delete the category from the list and also remove it  
from any events it was assigned to.
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Using the Media Palette
The Media Palette allows you to search and view organized libraries of image, video, and sound 
files. It presents each media type in a different tab, and each tab is divided into libraries and sub-li-
braries. Media items are displayed in the Media pane to the right of the libraries. Image files display 
as thumbnails with a descriptive label underneath. Movies and sound files display with a generic 
Movie or Sound icon and also contain a descriptive label underneath. The Search Tab allows you to 
perform keyword searches for media, and the Browse button allows you to import your own 
media into a project.

With an➤➤  open timeline or sequence project, click the Add Media button          and the 
Media Palette appears.

        

The Media Palette Image tab with the Arts Library selected and its subcategory, Instruments, open. 

To Use the Media Tabs: 

Click the colored tabs along the left side of the Palette to view the Libraries for each media type: 
Images, Sounds, and Movies. Select a library, and subcategory if available, from the scrolling list 
to view its available items in the Media pane on the right. Drag an item from the Media pane into 
your project and the Attach Media window appears. 

To Use the Browse Button: 

If you want to import your own media files into a project, the Browse button allows you to 
locate and import those files.  On the Libraries Tab, click the Browse button. Navigate to the 
media you want to use, click OK, and the Attach Media window appears.

To Use the Search Tab: 

Click the Search Tab to perform a keyword search 
for images, sounds, and movies. Select the media 
type(s) you want to search for, enter a keyword 
into the search field, and click the Search button. 
All available media items will appear in the Media 
pane on the right. Drag an item from the Media  
pane into your project and the Attach Media 
window appears. 

To Close the Media Palette: 

Click the  in the upper right-hand corner of the Media Palette to close it.

See also: Adding Media to a Project

Media types:  
Images, Sounds, 

and Movies

Media Libraries 
organized by 

subject matter

Click to close the Media Palette.Search all Media Libraries.

Media Palette Search Field
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Adding Media to a Project
There are four ways to add media to a project:

Double-click the media item in the Media Palette.➤➤

Select the media item from the Media Palette with a single click and press ➤➤ Enter.

Drag and drop a media item from the Media Palette onto a timeline or sequence.➤➤

Drag and drop media from your computer onto a timeline or sequence.➤➤

After any of these actions is performed, the Attach Media window appears with the selected 
media item. This window gives you the option to attach an image to an event or to the background.

Note:  Image files can be attached to events or to the project background. Movies and sounds can 
only be attached to events. 

 

                        
The Attach Media Window
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To Attach an Image to an Event

Double-click or drag and drop an image from1.	  the Media Palette into your project and the  
Attach Media window appears with the selected item. This window gives you the option to 
attach the image to an event or to the background. 
 

                           

Select the option to 2.	 Add to event. Choose an event from the list, and click OK. The image 
appears attached to the event on your project. In addition, an image icon appears to the left 
of the event. If necessary, drag the event up or down so that the image fits in the project, or 
resize the image by dragging its corner handles. 
           

Click the image to select it and its 3.	 media tray appears. Place your cursor over any icon in the 
tray to see its function.

➤➤  Minimize: Reduces the image to a small icon. To view it again, click the image icon to 
the left of the event.

➤➤  Resize: Click to resize the image to its original size. Alternatively, you can drag the 
corner handles in or out to resize the image.  

➤➤  Citation: Opens the Citation Tracker

➤➤  Delete: Deletes the image 

Note media tray
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To Add an Image to a Project Background

Double-click or drag and drop an image file from1.	  the Media Palette into your project and the 
Attach Media window appears with the selected image. This window gives you the option 
to attach an image to an event or to the background.  
                         

Select the option to 2.	 Add to Background and click OK. The image appears on your project 
and you can drag it anywhere you want. 
 
 
                                         

Click the image to select it and its 3.	 media tray appears. Place your cursor over any icon in the 
tray to see its function.

Minimize➤➤ : Reduces the image to a small icon. To view it again, click the image icon to the 
left of the event.

Resize➤➤ : Click to resize the image to its original size. Alternatively, you can drag the corner 
handles in or out to resize the image.  

Citation➤➤ : Opens the Citation Tracker

Delete➤➤ : Deletes the image 

Attach Media Window
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To Attach Sound or Movie to an Event

Double-click or drag and drop a sound or movie item from1.	  the Media Palette into your project 
and the Attach Media window appears with a generic icon of the selected item – either a 
sound or a movie icon. Because you cannot attach sound or movies to a project background, 
this window only gives you the option to attach the item to an event. 
 

Select an 2.	 event from the list and click OK. On the project, the media item is represented by 
an icon to the left of the selected event. 

Click the 3.	 icon to play the movie or sound file. If an event has more than one attachment, an 
icon of a plus sign will appear instead. Click the icon and select from the list of attachment 
icons that appear.  
 
 
                           

Sound icon

Media icon

Note:  Timeliner XE will play .flv movie files and .mp3 sound files within the Timeliner program. 
Other media file types such as QuickTime or .WAV will play in in your default browser.
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Deleting Media from a Project

To Delete Image Files

There are three ways to delete image files from an event or from the project background:

Click the ➤➤ image on the project and then click the Delete icon         from its media 
tray.

Click the ➤➤ image and choose Delete from the Edit menu.

Click the ➤➤ image and press the Delete key. 

To Delete Sound and Movie Files

To remove a sound or movie file from a project, ➤➤ right-click (Ctrl-click) the event  
and choose Remove Audio (Video) from the menu.
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Adding Notes to a Project

The Timeliner Notes feature allows you to add more detailed information to any event on a 
timeline or sequence project. You can also add notes that are not attached to specific events, such 
as introductions, overviews, or instructions.  There is no limit to the amount of text you put into a 
note. You can set up your note text to appear on the project or to display only when clicked. 

You can only have one note per event. However, there is no limit to the number of notes you can 
attach to the background. 

To Add a Note:

Select the 1.	 event to which you want to add a note. If you do not select an event, the note will 
be added to the background. Use one of the following methods to add a note. 

Click the ➤➤ Add Note button          on the main toolbar. Double-click in the note that ap-
pears and enter your text. Click off the note.

Choose ➤➤ Note from the Add menu. Double-click in the note that appears and enter your 
text. Click off the note.

Type text into the Notes field in the Event Editor. This will automatically create a note as ➤➤

soon as you tab or click off the field.

Select the note and 1.	 right-click (Ctrl-click) in the box and choose Resize to fit text.  
Alternatively, you can resize the note manually by clicking and dragging the blue corner handles. 
 
Notes that are attached to the background can be dragged to any location on the project, but 
notes that are attached to events cannot be moved.  

When a note is selected, a 2.	 media tray appears with the following options:

Minimize➤➤ : Reduces the note to a small 
icon. Click the icon to view the note.

Add Link➤➤ :  Allows you to link the note to a 
website.

Add Bullets➤➤ : Formats the note text with 
bullets

Citation➤➤ : Opens the Citation Tracker

Delete➤➤ : Deletes the note
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To Format Notes
Click a note to select it and use the Formatting Toolbar to customize the following:

Font, text size, and text style➤➤

Text Color➤➤

Line Thickness and color➤➤

Fill Color➤➤

To Edit Notes
To edit a note, you can either : 

Double-click the note and edit its text. ➤➤

Click in the Notes field of the Event Editor  ➤➤

and edit the note text.

To Delete Notes
To delete a note, select it and do one of the following:

Press the ➤➤ Delete key.

Click the ➤➤ Delete icon on its media tray.

Choose ➤➤ Delete from the Edit menu. 

To Print Notes
Choose 1.	 Print from the File menu.

In the Print dialog box, select 2.	 Notes page. 

All notes that are attached to events will print on a separate page  3.	
from the timeline or sequence.

Print Dialog

Tip:  Follow these steps to use a note 
to create a label for an image on  
your timeline.

Add a note to the background.1.	

Type a label such as John Adams. 2.	

Resize the note by clicking and 3.	
dragging the blue corner handles. 

With the note selected, use the 4.	
formatting toolbar to change the 
Fill Color and Line Color to white.
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Adding Links to a Project
The Timeliner Links feature allows you to create dynamic links from project events and notes to 
websites, other Timeliner projects, and program files such as Word documents, PDFs, etc.

To Add a Link to an Event

With a project open, choose 1.	 Save from the File menu. (To create links, the project must be 
saved first.)

Select an event and click the 2.	 Add Link button        on the main toolbar. The Add Link 
window appears.  This window allows you to create three types of links. Select the radio but-
ton that corresponds with what you want to link:

Select ➤➤ Web Site and enter a URL in the Link To box. Click Try This to test the link.

Select ➤➤ Timeliner Document and then click the Browse button. Locate the file you 
want to link to and click Select. 

Select ➤➤ File and then click the Browse button. Find the file you want to link to and click 
Select. 
 
Note: Each event can only have one type of link. 

Click 1.	 OK to make the link.

Once the link has been created, a 2.	 link icon appears next to the event. On an event with other 
attachments, click the plus-sign icon to view the link icon. Place your cursor over the link 
icon to see the link description. Click the link icon to open the link.

On an event 
with other at-
tachments, click 
the green plus-
sign icon to view 
the link icon.

Place your cursor 
over the link icon 
to see the link 
description.

Click the link icon 
to open the link.

Add a Link to a Web Site Add a Link to a Timeliner File or 
Other Document
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To Edit or Delete an Event Link
Click the 1.	 linked Event and then click the Link button on the main toolbar.  

In the 2.	 Add Link window, you can either edit the link or click the Remove button to delete 
it. Click OK.

To Add a Link to a Note

You can make links from notes to websites.

To add a link to a note, select a note and click the 1.	 Add Link button         on the  
main toolbar.

The 2.	 Add Link window appears. Type the website URL in the Link to field.

Type the name of the website (optional) in the 3.	 Link Name field. This name will appear at the 
bottom of the note. If you do not enter a name, the URL will appear at the bottom of the note.

Click 4.	 OK. The link name or URL appears in underlined blue text at the bottom of the note.

To open the link, click the 5.	 note to select it and then click the link on the bottom of the note. 
The link opens the appropriate URL in the Timeliner Browser window.

To Edit a Note Link
To edit a link you have added to a note:

Place your cursor over the link name or URL at the bottom of the note, and two icons, 1.	 Edit 
and Delete, appear to the right of the link. 

Click the 2.	 Edit icon,           and the Add Link to Note window appears containing the 
information that was previously entered for the link. Make any changes and click OK. 

To Delete a Note Link
To delete a link you have added to a note:

Place your cursor over the link name or URL at the bottom of the note, and two icons, 1.	 Edit 
and Delete, appear to the right of the link. 

Click the 2.	 Delete icon        and the link is deleted. 

Add Link to Note Window

Enter the URL.

Enter the website 
name.
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Using the Slideshow View
The Slideshow feature allows you to turn any timeline or sequence into an interactive, multimedia 
presentation. Each event becomes a slide that presents its attached media, notes, and links. You can 
set up the pace, transitions, and the look and feel using the available background templates or ones 
that you customize.

To Set Up a New Slideshow
Click the Slideshow View button        on the main toolbar. The Slidshow setup screen appears. 
Place your cursor over any option on this screen to get its description in the info box. 

Slideshow Title: If you have given your project a title, it will appear in this field. Otherwise,  
enter a title for your slideshow. It will appear on a Title slide at the beginning of your slideshow. 

Created by: Enter an author name to your slideshow. The author name will appear on a Title 
slide at the beginning of your slideshow.

Background Theme/Custom Setup: Select the Theme option and then select one of  
the available themes from the list. Click Custom Setup to customize the background for  
your slideshow.

Auto advance: Select this to advance the slides by the number of seconds you set.

Only Show Events with Media Attachments: This option appears if one or more of your 
project events has media attached. Select it to display only those event slides that have media in 
the slideshow.

Loop: Starts your slideshow over again when you reach the last slide.

Transition: Choose a transition style from this drop-down menu.

Run Slideshow: Plays the slideshow according to your settings.

Exit the Slideshow: Press the Esc key to exit the slideshow at any time. 

Slideshow Setup Window
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Custom Options for a Slideshow

To Customize the Slideshow Backgound
If you select the Custom Setup, new options appear for setting a background and frame.  

Click one of the three options, ➤➤ Solid Color, Texture, or Pattern, and then click the box 
to the right to choose from its menu of available options.

Select ➤➤ Apply Slide Border to put a border on each slide.

Click the ➤➤ Frame box to choose from its menu of available options. Frames are put 
around images on each slide.

Select ➤➤ No Frame if you prefer your slides to have no frame.

To Set the Slideshow Font
The font used in the slideshow is the font set in the Setup window. To change the font, choose 
Setup from the File menu. Click the Events tab and select a font from the Text drop-down 
menu. Adjust the font style and color with the available options.

Slideshow Setup Window
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Using the Spell Checker

There are two ways to spell check with Timeliner.  You can use the automatic spell checker to 
check spelling dynamically or you can use the spell check tool. 

To Use the Automatic Spell Checker
The automatic spell checker preference is on by default. With automatic spell checking, a wavy red 
line appears below any words the dictionary does not recognize. You can right-click (Ctrl-click) the 
wavy red underlined word to see a list of suggested spellings, and then make a selection from the 
list.  The right-click menu also contains the option to add the selected word to the dictionary.

To Turn off the Automatic Spell Checker

Choose Preferences from the Timeliner XE menu and deselect the option to Check  
spelling as you type located on the General tab.

To Use the Spell Check Tool
You can activate a spell check anytime by choosing Spell Check from the Tools menu. When 
the first misspelled or unrecognized word is located, the Spelling window appears.

Please note that the following items will not be spell checked:

Date fields (such as the When field in the Event Editor and the Start and End fields in the ➤➤

Setup window and Add Event window)

Category fields (in the Event Editor and the Add Category field on the Setup window)➤➤

Citation Tracker fields➤➤

The Created by field in the Slideshow View➤➤

URLs (in the Link To field of the Add Link window or the URL field in the Research Assign-➤➤

ment Wizard)

The Search field in the browser➤➤

Spelling Window
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Using the Research Tools
Use the Timeliner Research tools to research and gather information for events, capture  
images, and make direct links from events to specific webpages.  Timeliner keeps track of the  
information and media you gather with its built-in Citation Tracker.   

To Open the Research Tools

Open the Timeliner Research tools from within any timeline or sequence project to access  
information and media from the Internet. 

Click the ➤➤ Research button          at the top right of the project window and the  
Timeliner will open its Research Browser window. The Event Editor remains on top of  
the screen, allowing you to add events, notes, and media directly into Timeliner as you do 
your research. The Browser Toolbar allows you to search for and access websites, capture 
images, and create weblinks to events. The default Research Home Page has direct access 
to prescreened websites appropriate for many academic research topics. 

Note:  If you are in Sequence mode and the Event Editor is not open, click the Editor button on 
the top of the window. 

The Browser Toolbar

Place your cursor over any tool in the Browser Toolbar to see its function. 

Return to   
your project

Research 
Home Page

Event Editor

Timeliner 
Browser Tool-

bar

Image Capture tool

Add Link tool

Search field

Reload page Increase or decrease 
font size

Research button

Note:   Timeliner’s Research 
Browser is streamlined for 
use in an academic setting.  
Therefore, it does not support 
pop-ups, downloading files, or 
installing plug-ins.  This results 
in more productive time spent 
researching on the web.

Timeliner Research Browser
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To Research, Gather, and Cite Event Data

Use the Research Home Page links or the Search tool to research a topic and enter informa-
tion directly into your timeline or sequence project.  Timeliner keeps track of the information you 
gather with its built-in Citation Tracker.   

With the Research Browser window open, click a Weblink 1.	
on the Research Home Page or use the Search field to 
find and open a website. (Note: The Timeliner search field 
defaults to the Google search engine. You can change that 
default in Timeliner Preferences.)

With the website open, enter event information into the 2.	
What and When fields of the Event Editor (or just into 
the What field for a sequence). 

Place your cursor over the event’s Citations field in the 3.	
Event Editor. Click the Add button             that appears, 
and the CitationTracker opens. 

Click 4.	 Cite current webpage to automatically collect the                                              
 URL, page title, and current date. Click OK.

Click the 5.	 Timeliner or Sequence button at the top of the page to return to your proj-
ect. Click the Citation icon next to the event to view its citation. Click Close when you are 
done.  

 
Note:  Entering data into the When field for a timeline project is optional. While conducting  
research, you can simply enter information into the What field of the Event Editor. Events  
without When information, however, will appear in the Event Editor but not in an Event Flag  
on the timeline.

Citation Tracker window

Citation icon
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To Capture and Cite an Image

Use the Image Capture tool in the Timeliner Browser Toolbar to capture any image from a  
webpage. Use it to capture an entire image or select a specific section of an image or webpage. 
Each time you capture an image, the Citation Tracker automatically captures its URL, webpage  
title, and date of capture.

From your timeline or sequence project, click the 1.	 Research button to open the Research 
Browser window. 

Use the Search field or the available links to locate an image 2.	
that you want to capture.

Click the 3.	 Image Capture tool on the Browser 
Toolbar. Position the cursor at the top of the image and drag 
across the image. Release the cursor and the Add Media 
window appears with a preview of the captured image.

You can choose to attach the image to an event or the 4.	
background. Make your selection and click OK.  
 
      If you attach the image to an event:

Click in the event’s ➤➤ Citations column on the Event 
Editor and the Citations window appears. Click the 
Graphics tab to see how the citation information was 
captured along with the image automatically. Click OK. 

Or you can return to the project window and select the ➤➤
image on the project. Click the Citation icon on its 
media tray and the Citations widow appears. Click the 
Graphics tab to see how the citation information was 
captured along with the image automatically. Click OK.  
 

If you attach the image to the background:

Return to the project window and select the image on ➤➤  
the project. Click the Citation icon on its media tray 
and the Citations window appears. Click the Graphics  
tab to see how the citation  information was captured  
along with the image automatically.  
Click OK.  

Citation Tracker window



Timeliner XE Reference Guide

62

To Print Research Citations

Timeliner provides you the option to print all the citations for a project separately from the  
timeline or sequence.

Choose 1.	 Print from the File menu. 

Select the 2.	 Citations page option. 

Select or deselect other options as desired and click 3.	 Print.
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To Add a Web Link to an Event

Use the Links tool on the Browser Toolbar to create a direct link from any event in your project to 
a designated webpage. Once an event is linked, you can open its webpage from within your project. 

Click the 1.	 Research button          to open the Research tools.

Use the Search field or the available links to locate a webpage that you want to link to an event 2.	
in your project.

Click the 3.	 Link button. The Add Web Link window appears with the URL of the website on 
the left and a list of your events on the right. Select the event to which you want to make the 
link and click OK. 

Click the 4.	 Timeline or Sequence button on the top of the screen to return to your project. 
Place your cursor over the icon that appears next to the linked event to see the title and URL 
of the Weblink. Click the icon to open the link.

Add Link to Event
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About Timeliner Activities
Timeliner offers three different types of Activities: Research Activities, Challenges, and Finish 
Me projects. There are a number of ready-made activities included in the program and you can 
also create your own. 

Research Activities

	 Research Activities provide students with structure and parameters for conducting 	
	 research. Each one includes an introduction, assignment instructions, and links to      	
	 prescreened websites. This directed research helps students collect and organize key 	
	 information and present what they find in a timeline, slideshow, or sequence project. 

Challenge Activities

	 Challenge Activities present a dynamic, interactive environment in which students earn 	
	 points and track their time spent putting timeline events in the correct order. 

Finish Me Activities

	 Finish Me Activities include notes that instruct students how to complete a timeline or 	
	 sequence project by adding additional events, notes, or media. 

To Open an Activity
On the Main Menu, select the Choose an Activity Tab and select one of the three Activity 
types from along the top of the screen. 

To open a ready-made activity, choose a ➤➤ subject from the Subject column (use the  
up and down arrows to see more), select an activity from the list, and click Open.

To make your own activity, click the ➤➤ Create Activity button and click Open.

Choose an Activity Screen
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Using and Making Research Activities

To Use a Ready-Made Research Assignment

Ready-made Research Activities provide everything students need to research a topic and organize 
information gathered in an academically appropriate, prescreened Internet environment. 

On the 1.	 Main Menu, click the Choose an Activity Tab. Click the Research button and 
then select a subject from the Subject column.  
 

                              

Choose a 2.	 Research Activity from the list and click Open. 
 

The Research Assignment appears in the Timeliner Browser window with the Event Editor at 3.	
the top. Below the Browser Toolbar are two tabs, one for the Assignment and the other for the 
Research Home Page. 
 

                             

Introduction

Directions

Grolier 
Online article 
Weblink

Event Editor

Research Assignment in Timeliner Browser

Note:   Activity files with a  globe icon   are online files. These files may take longer to open.
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Read the Introduction and the Assignment Directions. 4.	

Click the 5.	 Weblink and it opens in a new tab.  
 

                     

Add events and notes into the Event Editor on the top of the screen. 6.	
 
Note:  You can add events and information in the What column with or without filling in the 
When column.  

Use the Research tools to capture images and links and the Citations field to collect citations. 7.	

Click the 8.	 Assignment Tab to refer back to the Assignment if necessary. 

To view your timeline or sequence project as you work, click the 9.	 Timeline or Sequence 
button on the top of the window. Click the Research button to return to your research.

When you are done, choose 10.	 Save from the File menu and you can save to the default My 
Projects folder (recommended) or to another location on your computer.

To open your saved research later, select the 11.	 Open a Project Tab on the Main Menu, and 
then select My Files from the Subject column. From there, you can open the file from the 
default My Projects folder or navigate to the location where you saved your project.  

Research button
 
Timeline button

Browser Toolbar 
with Research 
tools
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To Make Research Activities

You can create and save Research Activities for students to follow, complete with instructions, 
websites, and resources that you choose ahead of time. The Research Activity Wizard will step you 
through the process.

On the 1.	 Main Menu, click the Choose an Activity Tab. Click the Create Activity button 
and a New Activity window appears. 
 

                          

Click the 2.	 Research radio button and then click OK. A Research Activity Wizard 
appears. The Research Activity Wizard will take you through a series of five screens that enable 
you to customize a new Research Activity for any subject you choose. 
 
                   

Follow the instructions on each screen to create your Research Activity. Click 3.	 Next when you 
are done with a screen. 

At the final screen, click 4.	 Finish and the Research Activity will automatically save to My Activi-
ties. Then, the completed Research Activity will open for you to review.

To access this activity, select the 5.	 Choose an Activity Tab on the Main Menu. Select My 
Activities from the Subject menu, choose the file, and click Open. The activity opens as an 
untitled project template so that students can save it with a different name after they complete 
their work.

Research 
Assignment 

button

Activity  
description

Follow the 
instructions on 

each screen.

Click Next to 
continue to the 
next screen.

New Activity Window

Research Assigment Wizard
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Using and Making Challenge Activities

To Use Challenge Activities

Each ready-made Challenge Activity presents a dynamic, interactive environment in which students 
earn points and track their time spent putting timeline events in the correct order.

On the 1.	 Main Menu, click the Choose an Activity Tab. Click the Challenge button and 
then select a subject from the Subject column.  
 

                             

Choose a 2.	 Challenge Activity from the list and click Open.

The 3.	 Challenge window appears. Drag Event Boxes into the correct position in the time-
line.   If you make a mistake, drag the Event to its correct location or back up to the top of the 
window. 

                  

Click 4.	 Done to get your score and continue on to the Bonus Round. If any events were mis-
placed, they fly back up to the top of the window and you must try again.

In the Bonus Round, choose the correct category from the drop-down list that appears above 5.	
each event. In the Bonus Round, you are only allowed one chance to get it right.      
          
Note:  A Bonus Round is available only for timelines that have designated categories for events. 

Click 6.	 Done and a Reward animation plays. Click Done to get your printable Challenge Results. 
Click Done on the Challenge Results screen to go back to the Timeliner main screen.

Drag Event 
Boxes into 
the correct 
position in 
the timeline. 

Challenge Results Challenge Activity
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To Make Challenge Activities

Assess your students’ knowledge of facts by making your own Challenge Activities. A Challenge Ac-
tivity can be made from any timeline with 15 or fewer events. The Challenge Activity Wizard steps 
you through a series of four screens that enable you to make a timline into a Challenge Activity. 

On the 1.	 Main Menu, click the Choose an Activity Tab. Click the Create Activity button 
and a New Activity window appears. 
 

                         

Click the 2.	 Challenge radio button and then click OK. At the next window, locate and select 
a timeline file and click Select. A Challenge Wizard appears. 

Follow the instructions on each screen to create your Challenge Activity. Click 3.	 Next when you 
are done with a screen.

When you are done, click 4.	 Finish. Save the Challenge in the Save window and the completed 
Challenge Activity will open for you to review.

To access this activity, select the 5.	 Choose an Activity Tab on the Main Menu. Select My 
Activities from the Subject menu, choose the file, and click Open. The activity opens as an 
untitled project template so that students can save it with a different name after they complete 
their work. 

Tip:  You can open and save any timeline file as a Challenge by choosing Save as Challenge 
from the File menu. Continue with step 3 above.

Challenge Wizard

New Activity Window
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Using and Making Finish Me Activities

To Use Finish Me Activities

Choose ready-made Finish Me Activities from a variety of subject areas.

On the 1.	 Main Menu, click the Choose an Activity Tab and then click the  
Finish Me button. 
 

                          

Select a 2.	 subject in the Subject column, select an Activity from the list, and click Open.

The Finish Me Activity opens with instructions for how it should be finished.  3.	
 

                          

Follow the instructions to complete the activity. Choose 4.	 Save from the File menu when you 
are done if you want to save or print the results. You can save to the default My Projects folder 
(recommended) or to another location on your computer.

To open your saved Finish Me activity later, click the 5.	 Open a Project Tab on the Main 
Menu, and then select My Files from the Subject column. From there, you can open the file 
from the default My Projects folder or navigate to the location where you saved your project.  

Finish Me Activity
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To Make Finish Me Activities

First, create or open a timeline or sequence project that you want to use as a Finish Me Activity. 1.	
Make sure you include a note with instructions for how you want the project finished. Save the 
file to the My Projects folder.

On the 2.	 Main Menu, click the Choose an Activity Tab. Click the Create Activity button 
and a New Activity window appears. 
 

                         

Select 3.	 Finish Me and click OK.

At the next window, browse to select the project file you want to save as a Finish Me Activity 4.	
(the window will open to My Projects by default). Click Select and the project opens with a 
Finish Me Wizard in front.

Enter a title for your Finish Me Activity and click 5.	 Finish. A Save window opens directing you to 
save the file to the My Activities folder.

To access this activity, select the 6.	 Choose an Activity Tab on the Main Menu. Select My Proj-
ects from the Subject menu, choose the file, and click Open. The activity opens as an untitled 
project template so that students can save it with a different name after they complete their 
work.

Finish Me Wizard
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Preferences
The Timeliner Preferences window allows you to set certain application options for your computer.

To Open the Preferences Window 

Windows: ➤➤ Choose Preferences from the Tools menu. 

Macintosh➤➤ : Choose Preferences from the Timeliner XE menu.

The Preferences window contains four tabs: General, Formats, Saving, and Internet. Each tab 
presents options that can be customized. Place your cursor over any option to get its description in 
a box below. All changes you make to preferences remain in effect, even after you quit Timeliner.

Along the bottom of each tab are the same three buttons: 

Restore Defaults:➤➤  Click to reset all preferences to the original Timeliner defaults. 

Cancel:➤➤  Click to cancel any changes that have been made to the preferences and close 
the window.

OK:➤➤  Click to save any new preferences you have set and close the window. 
 

General Preferences

Ask for language choice on startup 

Select this option if you want to display a language 
selection window when you open Timeliner.  The 
program defaults to English. If this box is checked 
you can choose Spanish. This check box is selected 
by default unless when you originally opened  
Timeliner, you selected Don’t ask me again  
on the language selection window. 

Check spelling as you type

Select this option if you want the program to auto-
matically check the spelling of words as you enter 
text. When automatic spell check is on, a wavy red 
line appears below any words the dictionary does 
not recognize. This check box is selected by default.

Play sound effects

Allows you to toggle the Timeliner sound effects (in Challenges, etc.) on or off. This check box is 
selected by default.

Move main toolbar to bottom

When selected, this option moves the main toolbar to the bottom of the Timeliner window below 
the Formatting Toolbar.

Preferences Window
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Formats Preferences
This tab contains two subsections to delineate the 
options: Date and Time.

Date Options

MM/DD/YYYY  
This radio button is selected by default. It displays  
and allows you to enter Timeliner dates in the 

Month/Day/Year format. 

DD/MM/YYYY	

Select this option to specify that you want to display 
and enter all Timeliner dates in the Day/Month/Year 
format. 

Display one million years ago as:  

These options allow you to select how years are labeled in Geologic timelines:
1 million (selected by default), 1,000,000, or 1 MYA.	  

Use BCE/CE instead of BC/AD
Select this option to change how years are labeled. Before Christ/Anno Domini (BC/AD) is the 
default, but you can select this check box to switch to Before Current Era/Current Era (BCE/CE).

Time Options

Use 24-hour clock

Select this if you want to use a 24-hour clock for displaying time. For example, a time of 2:30 PM 
would appear as 14:30.

Saving Preferences

Save project files to:

This field contains the default save location for all 
your projects, My Documents/TimelinerXE Documents/
My Projects.  You can change the default save location 
by clicking the Browse button to the right of the 
field, navigating to a new location, and clicking OK.

Save custom activities to:	

This field contains the default save location for all ac-
tivity files that you make, My Documents/TimelinerXE 
Documents/My Activities.  You can change the default 
save location by clicking the Browse button to the 
right of the field, navigating to a new location, and 
clicking OK.

Formats Preferences

Saving Preferences
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Internet Preferences

Default research home page	

This field displays the default home page  
for the Timeliner Research Browser, 
http://content.TimelinerXE.com/Research.
To change the home page, type a new  
web address in this field.

Default search engine	

This field displays the default search  
engine for the Timeliner browser, 
http://www.google.com/search?q=

To change the search engine, type a new web address in this field. You must type the new search 
engine address so it will perform a search when the search term is entered in the search field.

Here are some examples: 
http://www.google.com/search?q=

http://www.askkids.com/web?q=

Internet Preferences
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Using Keyboard Navigation
TimeLiner XE supports standard keyboard navigation for its major features. 

Note for Mac users: In order to enable full keyboard access on the Macintosh platform, Mac 
users should open the Keyboards & Mouse window in System Preferences and ensure that the 
All controls option is selected within the Full keyboard access section. Windows users do not 
need to change any settings.

To Use Keyboard Navigation with Timeliner :

Pressing the ➤➤ Tab key moves you forward (or down) one interface element at a time. 

Pressing ➤➤ Shift + Tab moves you back (or up) one element at a time.

You can also use the arrow keys (up, down, left, and right) to navigate through items such ➤➤

as lists, radio button groups, etc. 
 
For example, on the Citations window, you can press the Tab key to move down through 
all the fields on each tab and then through the buttons at the bottom of the window. 
Pressing the right arrow key moves you through the tabs at the top of the window and 
then through the radio buttons at the top of the tab.

Initiating Controls
When you tab to a control, press Enter to initiate it.  
 
For example, when you tab to the Category field in the Event Editor, press Enter to see the 
drop-down window of options. Tab through those options until you highlight the appropriate item, 
and then press Enter to make a selection and close the list.

Selecting Controls
The default method for selecting a control is to tab to it and then press the Spacebar to select 
the control (and keep it selected). Then you will be able to tab to another control in order to per-
form some action on the selected item. 

For example, you can tab to a flag and press Spacebar to select the flag. Then, using a keyboard 
shortcut (in this case, Ctrl + down arrow), you can jump directly to the Formatting Toolbar to 
format the flag.

If you tab to and select a note, image, video, or sound file, the media tray appears. Then you can 
tab through the options on the media tray and press Enter to select an option.

Editing Event Flag or Event Box Text
To edit the text of a timeline flag or sequence box, you can tab to the item and then press Enter. 
This displays the edit text box. When you are finished entering or editing text, you can tab away 
from the box.

Moving Flags/Spans/Boxes/Arrows
Once you tab to a flag, span, box, or arrow, you can use the arrow keys (up, down, left, and right) 
to change the position of the item.
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Keyboard Shortcuts

Macintosh Shortcuts

Timeliner XE Menu
Hide Timeliner XE	 zH	
Hide Others	 z-option-H	
Quit Timeliner XE	 zQ

File Menu
Open: 	 zO
Merge: 	 zM
Close: 	 zW
Save: 	 zS
Print: 	 zP

Edit Menu
Undo: 	 zZ
Redo: 	 zY
Cut: 	 zX
Copy: 	 zC
Paste: 	 zV

View Menu
Banner/Horizontal:	  z1
Vertical: 	 z2
Compact/Circular : 	 z3
Slideshow: 	 z4
Research Mode: 	 z5

Windows Shortcuts

File Menu
Open: 	 Ctrl-O
Merge: 	 Ctrl-M
Close: 	 Ctrl-W
Save: 	 Ctrl-S
Print: 	 Ctrl-P
Exit: 	 Alt-Shift-F4

Edit Menu
Undo: 	 Ctrl-Z
Redo:	 Ctrl-Y
Cut: 	 Ctrl-X
Copy: 	 Ctrl-C
Paste: 	 Ctrl-V

View Menu
Banner/Horizontal: 	 Ctrl-1
Vertical: 	 Ctrl-2
Compact/Circular : 	 Ctrl-3
Slideshow: 	 Ctrl-4
Research Mode: 	 Ctrl-5
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Menu Options
The following reference list provides a description of all the options available within the  
Timeliner menus.

Timeliner XE Menu (Mac only)

Preferences

Opens a Preferences window, where you can customize certain features and options of Timeliner 
for use on your computer (For Windows users, this is found in the Tools menu.)	

Hide Timeliner XE 

Hides Timeliner from the screen	

Hide Others	

Hides all other open programs and windows from the screen

Show All

Displays all open applications		

Quit Timeliner XE	

Closes the application (For Windows users, this is found in the File menu.)

File Menu

New

Opens the Main Menu, where you can choose to open a new file

Open

	Opens the Main Menu, where you can open a previously saved file 

Merge
Lets you merge a second timeline into the one you have open. Your new, merged timeline will be 
untitled, and your two original timelines will remain unchanged.

Close

Closes the project file you are working on but Timeliner remains open

Save

Let you save changes to your project 

Save As

Lets you give your project file another name or save it to a different location
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Save As Template

Lets you save the current file as a template file. The file will always open as an untitled copy of the 
project and the original will remain unchanged.

Save As Challenge

This option opens the Challenge wizard so that you can save the current timeline file as a Chal-
lenge Activity. 

Save As PDF

Opens a window similar to the Print window, where you can select which elements you’d like to 
appear in the PDF file: Timeline/Sequence, Media icons, Cut lines, Event Editor, Brainstorming Area 
(sequences only), Notes page, Citations page. You can also select the paper size and orientation. 
After you select your options, a second window appears where you can name the PDF and specify 
a Save location. 

Print

	Opens a Print window, where you can select which elements you’d like to print: Timeline/Sequence, 
Media icons, Cut lines, Event Editor, Brainstorming Area (sequences only), Notes page, Citations 
page. Click Print to open the Page Setup window, where you can choose a printer and the paper 
size and orientation. From there click OK to print.

Setup

Opens the Setup window, where you can customize a set of options for your timeline or sequence 

Exit (Windows only)  
Closes the application

Edit Menu

Undo

Undoes your last action

Redo
Undoes your last undo

Cut

Removes the selection from your project and adds it to the clipboard

Copy

Puts a copy of the selection into your computer’s clipboard

Paste

Puts a copy of the current clipboard contents at the cursor insertion point

Delete

Deletes the selected item. The Delete or Backspace key also does this.
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View Menu

Event Editor

Toggles the Event Editor on or off. The Event Editor opens by default for timelines.

Brainstorming Area (for sequences only) 

Toggles the Brainstorming Area on or off 

Category Legend

Toggles the Category Legend on or off. The Legend is visible by default if a timeline or sequence 
contains categories.

Banner/Horizontal

Opens the Banner View in a timeline or Horizontal View in a sequence

Vertical

Opens the Veritical View

Compact/Circular

Opens the Compact View in a timeline or Circular View in a sequence

Slideshow

Opens the Slideshow View

Research

Opens the Research Browser

Zoom In

Zooms project view closer

Zoom Out

Zooms project view farther away

Toolbar

This menu contains two submenus.
Top of screen: Places Main toolbar at the top of the screen (default position)
Bottom of screen:  Places Main toolbar at the bottom of the screen

Add Menu

Event

Opens the Add Event window

Note

Adds a note to the project background or a selected event
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Media

Opens the Media Palette 

Link

With an event selected, this opens the Add Link dialog box.

Citation

With an event, note, or image selected, this opens the Citations Tracker.

Tools Menu

Spell check

Opens the Spelling window and automatically begins a spell check of the entire file

Preferences (Windows only)

Opens the Preferences window, where you can set your application preferences

Clean up flags (for timelines only)

Moves all your Event Flags back to a predetermined location/height on the timeline

Arrange flags (for timelines only)

This menu item is available only when there are categories assigned to events. It contains  
two submenus:

Into groups by category: places flags assigned to the same category in the same          
(invisible) horizontal band on the canvas. There are four designated bands; after four          
categories, the bands are reused.
On alternate sides of the timeline by category: arranges categorized flags on 
either side of the timescale  

Move to Brainstorming Area (for sequences only)

	Moves the selected Event Box from the sequence back to the Brainstorming Area (only if the 
Brainstorming Area is turned on)

Align with this event (for sequences only)

Aligns all sequence boxes on the same horizontal line as the currently selected box (not an option 
in circular sequences)

Research Menu (research mode only)

Back

Moves you back one page in the Timeliner Browser

Forward

Moves you forward one page in the Timeliner Browser
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Home

Opens the Timeliner Browser default home page (The default home page can be changed in Pref-
erences.)

Open in Default Browser

Opens the selected item (media, link, etc.) in your computer’s default browser

Help Menu

Timeliner Help

Opens the Timeliner Reference Guide

Online Technical Support

Opens the Timeliner website, where you can find FAQs, updates, ready-made timelines, Teacher 
Tips, links to websites with information and images to add to your timelines, and receive the latest 
technical support information

Getting Started Guide

Opens the Timeliner Getting Started Guide

Tutorials

Displays a page containing helpful videos on how to use some of the basic features of Timeliner

About Timeliner XE

Displays an About window, which includes the program credits and version number
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Printing

Printing Timelines and Sequences

Timeliner allows you to print your current timeline or sequence project with additional options to 
print Media icons, Cut lines, the Event Editor, Brainstorming Area, notes, and Citation, lines.

Printing Timelines

The project will print in whatever view is currently shown on the screen. Zooming does 
not affect what is printed (i.e., if you are viewing your project at 75%, it will still print at 
100%). Expanding/compressing the timeline will affect how it prints (i.e., if you compress 
a timeline to the point where it’s displaying years, then it will print a year timescale with 
events placed accordingly).

Printing Sequences

Sequences will print exactly as they appear on the screen - the text will appear in boxes, 
and the boxes will be connected by arrows. Zooming does not affect what is printed (i.e., 
if you are viewing your project at 75%, it will still print at 100%). 

To print a timeline or sequence project:
Choose 1.	 Print from the File menu and a Print options window appears.  
 

                   

Select the options you want to print (see more about each one below), and click 2.	 Print. 
 

Windows:  
The Print dialog box appears. If you want to print in landscape orientation, click Properties 
and select Landscape. 
Macintosh:  
The Page Setup dialog box appears. If you want to print in landscape orientation, select the 
Landscape icon.

The Print dialog box will appear. The options depend on the type of printer you’re using. In 3.	
general, you choose the pages to print and the number of copies. Choose your options and 
click Print.
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Timeline or Sequence Print Options:

Timeline or Sequence: 

This check box is selected by default. Deselect it if you do not 
want to print the project. Note: the Media icons and Cut lines 
options will become grayed out. 

Media icons: 

Select to include the media icons on the printout. (Media 
icons include the green plus sign indicating media is linked 
to the event, the minimized note icon when a note is 
minimized, and the minimized graphic icon when a graphic 
is minimized. Note: If none of the events have associated 
media, this check box is grayed out.

Cut lines: 

Select to include cut lines on the printed document. Cut lines are lines that appear on the 
right and/or bottom edge of document, helpful for cutting and taping together printed time-
lines or sequences.

Event Editor: 

Select to print the Event Editor on a separate page, after the timeline or sequence.

Brainstorming Area: 

Select to print the Brainstorming Area on a separate page (available for sequences only). If there is 
nothing in the Brainstorming Area or if it has been turned off, this option is grayed out.

Notes page: 

Select to print all the notes in a project, separate from the timeline or sequence. If the project does 
not contain notes, this option is grayed out.

Citations page: 

Select to print all the project citations on a separate page, after the timeline or sequence. The 
citations will appear in standard MLA style. If the project does not contain citations, this option is 
grayed out.

Print Options
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Printing Slideshows

You can choose to print a copy of a Slideshow project. Slideshows will print one slide per page. 
Each slide will print exactly as it appears on the screen. 

To Print a Slideshow
On the Slideshow setup screen, choose 1.	 Print from the File menu.

Select the options you want to print (see more about each one below), and click 2.	 Print. 
 

Windows:  
The Print dialog box appears. If you want to print in landscape orientation, click Properties 
and select Landscape. 

Macintosh:  
The Page Setup dialog box appears. If you want to print in landscape orientation, select the 
Landscape icon.

The Print dialog box will appear. The options depend on the type of printer you’re using. In 3.	
general, you choose the pages to print and the number of copies. Choose your options and 
click Print.

Printing Challenge Results

After a Challenge Activity is completed, the Challenge Results screen can be printed. The screen 
contains the elapsed time for the Challenge and Bonus Round (if applicable) combined, the num-
ber of Challenge points earned, the number of Bonus Round points earned, and the grand total of 
points. It also contains Print and Done buttons.  

To Print Challenge Results
Click the ➤➤ Print button, and a dialog box appears. Type your name and click OK. Click 
Print on the next screen. The Challenge Results screen prints with your name directly  
below the Challenge Results text. 

Challenge Results Screen
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Printing Research Assignments

Any open Research Assignment can be printed for reference. However, even though the Event Edi-
tor can appear at the top of a Research Assignment, it will not print. Only the Assignment portion 
of the page will print. 

To Print a Research Assignment
With a Research Assignment open, click the 1.	 Print button. A preview of your printout ap-
pears. Choose Print.

Select the options you want to print (see more about each one below), and click 2.	 Print. 
 

Windows:  
The Print dialog box appears. If you want to print in landscape orientation, click Properties 
and select Landscape. 

Macintosh:  
The Page Setup dialog box appears. If you want to print in landscape orientation, select the 
Landscape icon.

The Print dialog box will appear. The options depend on the type of printer you’re using. In 3.	
general, you choose the pages to print and the number of copies. Choose your options and 
click Print.
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Saving
In addition to the standard Save and Save As options, Timeliner offers the following options for sav-
ing projects:

Save As Template
A project saved in template format will open as an untitled copy of that file. The original file will 
remain unchanged. 

Save As Challenge (timelines only)
Saving a timeline as a Challenge scrambles its events and saves it in the Activities folder. When the 
Challenge Activity is opened, you are challenged to put the events back into in the correct order.
Any timeline with 15 or fewer events can be saved as a Challenge. 

Save As PDF

Saves any project as a PDF so that it can be shared, viewed, and printed independent of Timeliner.

To Save a Project or Activity File

Choose 1.	 Save from the File menu.

In the Save window that appears, select the folder in which to save the document (My Projects 2.	
or My Activities are the default folders).

Enter a name for the file, then click 3.	 Save.

To Save a Project or Activity Under a New Name

Choose 1.	 Save As from the File menu.

In the Save window that appears, select the folder in which to save the document (My Projects 2.	
or My Activities are the default folders).

Enter a name for the file, then click 3.	 Save.

To Save a Project as a Template

Choose 1.	 Save As Template from the File menu.

In the Save window that appears, select the folder in which to save the document (My Projects 2.	
is the default folder).

Enter a name for the file, then click 3.	 Save. 

To Save a Timeline as a Challenge

Choose 1.	 Save As Challenge from the File menu and a Challenge Wizard appears. 

Follow the on-screen instructions to create and save a Challenge Activity.2.	
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